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Introduction

The Cassegrain form of this telescope is an evolution of the camera designed by Bernhard
Schmidt in 1929. The original Schmidt camera featured a thin aspheric plate placed at the
center of curvature of the spherical primary mirror, which was able to eliminate spherical
aberration. The Schmidt-Cassegrain telescope featured in this tutorial has a spherical
secondary mirror that is intended to be mounted on the inside of the aspheric corrector
plate. Although this results in some residual oft-axis coma and focal plane curvature, the
overall form is extremely compact. Telescopes based on this design are widely used in the

amateur astronomical community.

The Schmidt-Cassegrain telescope demonstrated in this tutorial uses an aspheric corrector
lens and two spherical mirrors. The aspheric corrector is created using the Aspheric Even
Lens 3D part from the Ray Optics Module Part Library. The spherical parts use the
Spherical Mirror 3D part. An overview of the telescope can be seen in Figure 1.

Another closely related catadioptric telescope model, the Gregory-Maksutov Telescope,
can also be found in the COMSOL Ray Optics Module Application Library.

Figure 1: Overview of the Schmidt-Cassegrain telescope.
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Model Definition

Details of the Schmidt-Cassegrain telescope used in this example can be found in Ref. 1.
The chosen design has a 203.2 mm diameter entrance pupil and an 710 focal ratio. The

nominal optical prescription is given in Table 1.

TABLE I: SCHMIDT-CASSEGRAIN TELESCOPE OPTICAL PRESCRIPTION.

Identity Details Material Radius Thickness Diameter
(mm) (mm) (mm)
Object — — Infinity 0
| Reference surface — — 50.0000 0
2 Central obstruction — — 10.0000 70.0
Stop Corrector lens, entr. N-BK7 — 4.0000 203.2000
4 Corrector lens, exit? — -56,118.2800 7.0000 203.2458
5 Secondary mirror — — 303.8701 0
ref.

6 Primary mirror® Mirror -812.8000 -303.8701  206.1674
7 Secondary mirror Mirror —-252.6581 303.8701 53.9204
8 Primary mirror ref. — — 200.0000 0
Image Image surface — — — 17.8789

a. Even asphere. Cocfficients are: A4 = 6.431003e-10, Ag = 3.11397e-16. Units are mm.
b. Primary mirror central hole diameter: d,gje = 50.0000 mm.

The telescope geometry is constructed using parts from the Ray Optics Module Part
Library. The Schmidt corrector is created using an instance of the Aspheric Even Lens 3D
part, whereas the Spherical Mirror 3D part is used to create the primary and secondary
mirrors. Note that the optical prescription has been reformatted to allow these parts to be
defined in a somewhat arbitrary sequence; that is, the order in which optical elements are
placed in a COMSOL geometry sequence does not affect the ray trace. However, the
optical elements can be placed relative to one another by making use of built-in work-

planes in each of the Part Instances.

The resulting Schmidt-Cassegrain telescope geometry sequence is shown in Figure 2.
Detailed instructions for creating the geometry can be found in Appendix — Geometry

Instructions.

The default Physics-controlled mesh should be slightly refined in order to reduce the

effects of discretization. The mesh used in this simulation can be seen in Figure 3.
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Figure 2: The Schmidt-Casseqrain telescope geometry sequence.
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Figure 3: The Schmidt-Casseqrain telescope mesh.
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Results and Discussion

A ray trace has been performed using three wavelengths (486 nm, 546 nm, and 656 nm)
at three field angles (0, 0.125, and 0.25 degrees). Figure 4 shows the resulting ray

trajectories; the Color Expression represents the ray positions on the image surface.

In Figure 5 the intersection of the rays with the image surface is shown. This spot diagram

shows each of the three field angles, where the Color Expression is the wavelength.
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Figure 4: Ray diagram for the Schmidt-Cassegrain telescope coloved by radial distance from
the centroid.
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Figure 5: Spot diagram for the Schmidt-Cassegrain telescope coloved by wavelength. The Airy
dusc is shown for refevence in the lower-left corner.
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Application Library path: Ray_Optics_Module/Lenses_Cameras_and_Telescopes/
schmidt_cassegrain_telescope

Modeling Instructions

From the File menu, choose New.

NEW
In the New window, click Model Wizard.
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MODEL WIZARD
I In the Model Wizard window, click [l 3D.

2 In the Select Physics tree, select Optics>Ray Optics>Geometrical Optics (gop).

3 Click Add.

4 Click @ Study.

5 In the Select Study tree, select Preset Studies for Selected Physics Interfaces>Ray Tracing.
6 Click [/ Done.

GLOBAL DEFINITIONS

Parameters |: Lens Prescription

I In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Parameters 1: Lens Prescription in
the Label text field. The lens prescription will be added when the geometry sequence is
inserted in the following section.

Parameters 2: General
The simulation parameters can be loaded from a text file.
I In the Home toolbar, click Pi Parameters and choose Add>Parameters.

2 In the Settings window for Parameters, type Parameters 2: General in the Label text
field.

3 Locate the Parameters section. Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file
schmidt_cassegrain_telescope_parameters.txt.

SCHMIDT-CASSEGRAIN TELESCOPE

Insert the prepared geometry sequence from file. You can read the instructions for creating
the geometry in the appendix. Following insertion, the lens definitions will be available in
the Parameters node.

I In the Model Builder window, under Component | (compl) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose mm.

4 In the Label text field, type Schmidt-Cassegrain Telescope.

5 In the Geometry toolbar, click Insert Sequence and choose Insert Sequence.
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6 Browse to the model’s Application Libraries folder and double-click the file
schmidt_cassegrain_telescope_geom_sequence.mph.

7 In the Geometry toolbar, click [E2 Build All.

8 Click the 'I]]= Orthographic Projection button in the Graphics toolbar. Compare the
resulting geometry to Figure 2.

ADD MATERIAL
I In the Home toolbar, click £35 Add Material to open the Add Material window.

2 Go to the Add Material window.
3 In the tree, select Optical>Schott Glass>Schott N-BK7 Glass.
4 Click Add to Component in the window toolbar.

5 In the Home toolbar, click 37 Add Material to close the Add Material window.

MATERIALS

Schott N-BK7 Glass (matl)
I In the Settings window for Material, locate the Geometric Entity Selection section.

2 From the Selection list, choose All (Corrector).

GEOMETRICAL OPTICS (GOP)

I In the Model Builder window, under Component 1 (compl) click Geometrical Optics (gop).
2 Select Domain 2 only.

3 In the Settings window for Geometrical Optics, locate the Ray Release and Propagation
section.
4 From the Wavelength distribution of released rays list, choose Polychromatic,

specify vacuum wavelength.

5 In the Maximum number of secondary rays text field, type 0. In this simulation stray light

is not being traced, so reflected rays will not be produced at the lens surfaces.

Medium Properties |

I Inthe Model Builder window, under Component | (compl)>Geometrical Optics (gop) click
Medium Properties I.

2 In the Settings window for Medium Properties, locate the Medium Properties section.

3 From the Refractive index of domains list, choose Get dispersion model from material.
The material added above contains the optical dispersion coefficients which can be used

to compute the refractive index as a function of wavelength.
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Material Discontinuity |

I In the Model Builder window, click Material Discontinuity 1.

2 In the Settings window for Material Discontinuity, locate the Rays to Release section.
3 From the Release reflected rays list, choose Never.

Mirrors

I In the Physics toolbar, click mw Boundaries and choose Mirror.

2 In the Settings window for Mirror, type Mirrors in the Label text field.

3 Locate the Boundary Selection scction. From the Selection list, choose Mirrors.
Obstructions

I In the Physics toolbar, click mw Boundaries and choose Wall.

2 In the Settings window for Wall, type Obstructions in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose Obstructions.
4 Locate the Wall Condition section. From the Wall condition list, choose Disappear.
Image

I In the Physics toolbar, click mw Boundaries and choose Wall.

2 In the Settings window for Wall, type Image in the Label text field.

3 Locate the Boundary Selection section. From the Selection list, choose All (Image plane).
Release from Grid |

Release rays from a set of hexapolar grids using quantities defined in the Parameters 2:
General node.

I In the Physics toolbar, click #2% Global and choose Release from Grid.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.
3 From the Grid type list, choose Hexapolar.

4 Specify the g, vector as

dx1  x
dy1 'y
dz

5 Specify the r, vector as

0 x
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0

1z

6 In the R, text field, type P_nom/2.
7 In the N, text field, type N_ring.

8 Locate the Ray Direction Vector section. Specify the Ly vector as

vx1l x
vyl y
vz

9 Locate the Vacuum Wavelength section. From the Distribution function list, choose

List of values.

10 In the Values text field, type lam1 lam2 lam3. These wavelengths were defined in the
Parameters 2: General node.

Release from Grid 2

I Right-click Release from Grid | and choose Duplicate.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 Specify the g, vector as
dx2 x
dy2 y

4 Locate the Ray Direction Vector section. Specify the Ly vector as

VX2  x

vy2 y

Release from Grid 3

I Right-click Release from Grid 2 and choose Duplicate.

2 In the Settings window for Release from Grid, locate the Initial Coordinates section.

3 Specity the q, vector as

dx3 x
dy3 vy
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4 Locate the Ray Direction Vector section. Specify the Ly vector as

VX3 x
vy3 y
MESH |

I In the Model Builder window, under Component | (compl) click Mesh 1.
2 In the Settings window for Mesh, locate the Physics-Controlled Mesh section.

3 From the Element size list, choose Finer. Slightly refine the mesh to improve the ray

tracing accuracy.

4 Click [E§ Build All. The mesh should look like Figure 3.

STUDY |
Step I: Ray Tracing
I In the Model Builder window, under Study I click Step I: Ray Tracing.
In the Settings window for Ray Tracing, locate the Study Settings section.

From the Time-step specification list, choose Specify maximum path length.

In the Lengths text field, type 0 1250.

2
3
4 From the Length unit list, choose mm.
5
6 In the Home toolbar, click = Compute.

RESULTS

Ray Diagram

Now, make some modifications to the default Ray Trajectories plot.

I In the Settings window for 3D Plot Group, type Ray Diagram in the Label text field.
2 Locate the Color Legend section. Select the Show units check box.

Ray Trajectories |
In the Model Builder window, expand the Ray Diagram node.

Color Expression |
I In the Model Builder window, expand the Ray Trajectories | node, then click

Color Expression |.

2 In the Settings window for Color Expression, locate the Expression section.
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3 In the Expression text field, type at ('last',gop.rrel). This expression gives the
radial distance from the centroid of the spot on the image plane generated by each

release feature.

4 From the Unit list, choose pm.

Filter |

I In the Model Builder window, click Filter I.

2 In the Settings window for Filter, locate the Ray Selection scction.

3 From the Rays to include list, choose Logical expression.

4 In the Logical expression for inclusion text field, type at(0,atan2(qy,qx)>-pi/2).
This filter removes 1 /4 of the rays so that the optical geometry is visible.

Ray Diagram

In the following we add and color surface plots to show the various telescope optical

elements.

Surface |

I In the Model Builder window, right-click Ray Diagram and choose Surface.

2 In the Settings window for Surface, locate the Coloring and Style section.

3 From the Coloring list, choose Uniform.

4 From the Color list, choose Gray.

Selection |

I Right-click Surface I and choose Selection.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Mirrors.

Surface 2

In the Model Builder window, under Results>Ray Diagram right-click Surface |1 and choose

Duplicate.

Selection |

I In the Model Builder window, expand the Surface 2 node, then click Selection 1.
2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Obstructions.

Surface 2

I In the Model Builder window, click Surface 2.

2 In the Settings window for Surface, locate the Coloring and Style section.
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3 From the Color list, choose Custom.

4 On Windows, click the colored bar underneath, or — if you are running the cross-
platform desktop — the Color button.

5 Click Define custom colors.

6 Sct the RGB values to 105, 105, and 105, respectively.

7 Click Add to custom colors.

8 Click Show color palette only or OK on the cross-platform desktop.

Surface 3
Right-click Results>Ray Diagram>Surface 2 and choose Duplicate.

Selection |

I In the Model Builder window, expand the Surface 3 node, then click Selection 1.

2 In the Settings window for Selection, locate the Selection section.

3 From the Selection list, choose Clear Apertures.

Surface 3

I In the Model Builder window, click Surface 3.

2 In the Settings window for Surface, locate the Coloring and Style section.

3 Click Define custom colors.

4 Set the RGB values to 54, 140, and 203, respectively.

5 Click Add to custom colors.

6 Click Show color palette only or OK on the cross-platform desktop.

Transparency |

I Right-click Surface 3 and choose Transparency.

2 In the Ray Diagram toolbar, click Plot.

3 Click the Zoom Extents button in the Graphics toolbar. Compare the resulting
image to Figure 4.

Spot Diagram

I In the Home toolbar, click @1 Add Plot Group and choose 2D Plot Group.

2 In the Settings window for 2D Plot Group, type Spot Diagram in the Label text field.

3 Locate the Color Legend section. Select the Show units check box.

Spot Diagram |
I In the Spot Diagram toolbar, click . More Plots and choose Spot Diagram.
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2 In the Settings window for Spot Diagram, locate the Layout section.

3 From the Origin location list, choose Average over area. This option centers each spot on

the midpoint of all rays.
4 Click to expand the Annetations section. Select the Show circle check box.
5 In the Radius text field, type r_Airy.
Color Expression |
I Right-click Spot Diagram I and choose Color Expression.
In the Settings window for Color Expression, locate the Expression section.
In the Expression text field, type gop.lambda0.
From the Unit list, choose nm.

Click to expand the Range section. Select the Manual color range check box.

2

3

4

5

6 In the Minimum text field, type 425.

7 In the Maximum text field, type 675.

8 Locate the Coloring and Style section. Click : | | Change Color Table.
9 In the Color Table dialog box, select Rainbow>Spectrum in the tree.
10 Click OK.

11 In the Spot Diagram toolbar, click Plot.

12 Click the Zoom Extents button in the Graphics toolbar. Compare the resulting
image to Figure 5.

Appendix — Geometry Instructions

From the File menu, choose New.

NEW
In the New window, click Model Wizard.

MODEL WIZARD
I In the Model Wizard window, click iw 3p.

2 Click E,/ Done.

SCHMIDT-CASSEGRAIN TELESCOPE GEOMETRY SEQUENCE

I In the Model Builder window, under Component | (compl) click Geometry 1.

2 In the Settings window for Geometry, type Schmidt-Cassegrain Telescope
Geometry Sequence in the Label text field.
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3 Locate the Units section. From the Length unit list, choose mm.

GLOBAL DEFINITIONS

Parameters |

I In the Model Builder window, under Global Definitions click Parameters 1.
2 In the Settings window for Parameters, locate the Parameters section.
3 Click Load from File.

4 Browse to the model’s Application Libraries folder and double-click the file
schmidt cassegrain_telescope geom_sequence_parameters.txt. This file
contains details of the telescope optical prescription.

We now insert parts from the Ray Optics Parts Libraries which can be used to create each

of the telescope optical elements. Begin by inserting the corrector lens.

PART LIBRARIES
I In the Home toolbar, click % Windows and choose Part Libraries.

2 In the Model Builder window, under Component | (compl) click Schmidt-

Cassegrain Telescope Geometry Sequence.

3 In the Part Libraries window, sclect Ray Optics Module>3D>Aspheric Lenses>

aspheric_even_lens_3d in the tree.
4 Click T& Add to Geometry.

5 In the Select Part Variant dialog box, select Specify clear aperture diameter in the
Select part variant list.

6 Click OK.

SCHMIDT-CASSEGRAIN TELESCOPE GEOMETRY SEQUENCE

Corrector
I In the Model Builder window, under Component | (compl)>Schmidt-

Cassegrain Telescope Geometry Sequence click Aspheric Even Lens 3D | (pil).

2 In the Settings window for Part Instance, type Corrector in the Label text field.
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3 Locate the Input Parameters section. In the table, enter the following settings:

Name Expression Value Description
RI R1_corr Om Radius of curvature, surface | (+
convex/-concave)
R2 R2_corr -56118 mm Radius of curvature, surface 2 (-
convex/+concave)
kil 0 0 Conic constant, surface |
k2 0 0 Conic constant, surface 2
A_norm 1[mm] I mm Aspheric normalization unit
A02_ | 0 0 2nd order aspheric term, surface |
A04_| 0 0 4th order aspheric term, surface |
A06_| 0 0 6th order aspheric term, surface |
A08_1I 0 0 8th order aspheric term, surface |
AlO_I 0 0 |0th order aspheric term, surface |
Al2_I 0 0 I2th order aspheric term, surface |
Al4_1 0 0 | 4th order aspheric term, surface |
Alé_lI 0 0 | 6th order aspheric term, surface |
Al8_|I 0 0 I8th order aspheric term, surface |
A20_1 0 0 20th order aspheric term, surface |
A22 | 0 0 22nd order aspheric term, surface |
A02_2 0 0 2nd order aspheric term, surface 2
A04 2 A04_corr 6.431E-10 4th order aspheric term, surface 2
A06_2 A06_corr 3.114E-16 6th order aspheric term, surface 2
A08_2 0 0 8th order aspheric term, surface 2
A10_2 0 0 |0th order aspheric term, surface 2
Al2_2 0 0 |2th order aspheric term, surface 2
Al4_2 0 0 |4th order aspheric term, surface 2
Al6_2 0 0 | 6th order aspheric term, surface 2
Al8_2 0 0 I8th order aspheric term, surface 2
A20 2 0 0 20th order aspheric term, surface 2
A22 2 0 0 22nd order aspheric term, surface 2
Tc Tc_corr 4 mm Center thickness
do do_corr 210 mm Lens full diameter
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Name Expression Value Description

dl 0 Om Diameter, surface |

d2 0 Om Diameter, surface 2

dl_clear 0 Om Clear aperture diameter, surface |
d2_clear 0 Om Clear aperture diameter, surface 2
nix nix 0 Local optical axis, x-component
niy niy 0 Local optical axis, y-component
niz niz -1 Local optical axis, z-component

Next, create the primary and secondary mirrors.

PART LIBRARIES
I In the Home toolbar, click % Windows and choose Part Libraries.

2 In the Model Builder window, click Schmidt-Cassegrain Telescope Geometry Sequence.

3 In the Part Libraries window, sclect Ray Optics Module>3D>Mirrors>spherical_mirror_3d
in the tree.

4 Click T Add to Geometry.

5 In the Select Part Variant dialog box, select Specify clear aperture diameter in the

Select part variant list.

6 Click OK.

SCHMIDT-CASSEGRAIN TELESCOPE GEOMETRY SEQUENCE

Secondary mirror
I In the Model Builder window, under Component | (compl)>Schmidt-

Cassegrain Telescope Geometry Sequence click Spherical Mirror 3D | (pi2).
2 In the Settings window for Part Instance, type Secondary mirror in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

Name Expression Value Description

R R_sec 252.66 mm Radius of curvature (+convex/-
concave)

Tc Tc_sec 7 mm Center thickness

do do_sec 60 mm Mirror full diameter

dl 0 0Om Mirror surface diameter

d_clear 0 Om Clear aperture diameter
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Name Expression Value Description

d_hole 0 Om Center hole diameter

niz -1 -1 Local optical axis, z-component

4 Locate the Position and Orientation of Output section. Find the
Coordinate system to match subsection. From the Take work plane from list, choose

Corrector (pil).
5 From the Work plane list, choose Surface 2 vertex intersection (wp2).
6 Find the Displacement subsection. In the zw text field, type z_sec.

Primary mirror

I In the Geometry toolbar, click - Parts and choose Spherical Mirror 3D.

2 In the Settings window for Part Instance, type Primary mirror in the Label text field.

3 Locate the Input Parameters section. In the table, enter the following settings:

Name Expression Value Description

R R_prim -812.8 mm Radius of curvature (+convex/-
concave)

Tc Tc_prim 20 mm Center thickness

do do_prim 215 mm Mirror full diameter

dl di_prim 206.17 mm Mirror surface diameter

d_clear 0 Om Clear aperture diameter

d_hole dh_prim 50 mm Center hole diameter

niz -1 -1 Local optical axis, z-component

4 Locate the Position and Orientation of Output section. Find the
Coordinate system to match subsection. From the Take work plane from list, choose

Secondary mirror (pi2).
5 From the Work plane list, choose Mirror vertex intersection (wpl).

6 Find the Displacement subsection. In the zw text field, type z_prim.
Finally, create the image plane and central obstruction.

PART LIBRARIES

I In the Geometry toolbar, click ¢ \ Parts and choose Part Libraries.

2 In the Model Builder window, click Schmidt-Cassegrain Telescope Geometry Sequence.
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3 In the Part Libraries window, sclect Ray Optics Module>3D>Apertures and Obstructions>

circular_planar_annulus in the tree.

4 Click T Add to Geometry.

SCHMIDT-CASSEGRAIN TELESCOPE GEOMETRY SEQUENCE

Image plane
I In the Model Builder window, under Component | (compl)>Schmidt-

Cassegrain Telescope Geometry Sequence click Circular Planar Annulus | (pi4).
2 In the Settings window for Part Instance, type Image plane in the Label text ficld.

3 Locate the Input Parameters scction. In the table, enter the following settings:

Name Expression Value Description
do d_img 40 mm Diameter, outer
dl 0 0Om Diameter, inner

4 Locate the Position and Orientation of Output section. Find the
Coordinate system to match subsection. From the Take work plane from list, choose

Primary mirror (pi3).
5 From the Work plane list, choose Mirror vertex intersection (wpl).
6 Find the Displacement subsection. In the zw text field, type z_img.
Central obstruction
I In the Geometry toolbar, click _ Parts and choose Circular Planar Annulus.

2 In the Settings window for Part Instance, type Central obstruction in the Label text
field.

3 Locate the Input Parameters scction. In the table, enter the following settings:

Name Expression Value Description
do d_obs 70 mm Diameter, outer
dl 0 0Om Diameter, inner

4 Locate the Position and Orientation of Output section. Find the
Coordinate system to match subsection. From the Take work plane from list, choose

Corrector (pil).
5 From the Work plane list, choose Surface | vertex intersection (wpl).
6 Find the Displacement subsection. In the zw text field, type z_obs.

7 Click [EE Build All Objects.
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8 Click the 'I]]= Orthographic Projection button in the Graphics toolbar.
9 Click the Zoom Extents button in the Graphics toolbar.

In the following sections we create selections that can be used to define the physics and
during postprocessing.

Corrector (pil)

I In the Model Builder window, click Corrector (pil).

2 In the Settings window for Part Instance, click to expand the Domain Selections section.
3 In the table, select the Keep check box for All.

4 Click to expand the Boundary Selections section. Click to select row number 2 in the
table.

5 Click New Cumulative Selection.

6 In the New Cumulative Selection dialog box, type Clear Apertures in the Name text
field.

7 Click OK.
8 In the Settings window for Part Instance, locate the Boundary Selections scction.

9 In the table, enter the following settings:

Name Keep Physics Contribute to
Surface | S Clear Apertures
Surface 2 S Clear Apertures

10 Click to select row number 4 in the table.

Il Click New Cumulative Selection.

12 In the New Cumulative Selection dialog box, type Obstructions in the Name text field.
13 Click OK.

14 In the Settings window for Part Instance, locate the Boundary Selections section.

I5 In the table, enter the following settings:

Name Keep Physics Contribute to
Surface | obstruction S Obstructions
Surface 2 obstruction S Obstructions
Edges S Obstructions

Secondary mirror (pi2)
I In the Model Builder window, click Secondary mirror (pi2).
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2 In the Settings window for Part Instance, locate the Boundary Selections section.
3 Click to select row number 2 in the table.

4 Click New Cumulative Selection.

5 In the New Cumulative Selection dialog box, type Mirrors in the Name text field.
6 Click OK.

7 In the Settings window for Part Instance, locate the Boundary Selections section.
8 In the table, enter the following settings:

Name Keep Physics Contribute to
Mirror surface \ Mirrors
Mirror rear surface S Obstructions
Mirror edges S Obstructions

Primary mirror (pi3)
I In the Model Builder window, click Primary mirror (pi3).

2 In the Settings window for Part Instance, locate the Boundary Selections section.

3 In the table, enter the following settings:

Name Keep Physics Contribute to
Mirror surface S Mirrors
Mirror rear surface v Obstructions
Mirror edges \ Obstructions

Image plane (pi4)
I In the Model Builder window, click Image plane (pi4).

2 In the Settings window for Part Instance, locate the Boundary Selections section.
3 In the table, select the Keep check box for All.

Central obstruction (pi5)

I In the Model Builder window, click Central obstruction (pi5).

2 In the Settings window for Part Instance, locate the Boundary Selections section.

3 In the table, enter the following settings:

Name Keep Physics Contribute to

All v Obstructions
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